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Before Starting Your First Project 

Create a profile to connect to Project Server or 

Project Online 

1. Open Microsoft Project 2016. 

2. When the application has opened, press the 

Esc key on your keyboard. 

3. Click on the File tab in the upper left corner. 

4. On the Info tab click the Manage Accounts 

button. 

 

 
 

5. In the Project Web App Accounts dialog, click 

the Add button. Give the account / connection 

a name, and specify the URL for your Project 

Server / PWA / Project Online instance. Also 

check the Set as default account option and 

click OK. 

 

 
 

6. Select the Choose an account option and click 

OK. 

 

 
 

7. Close Microsoft Project 2016. 

Set application default options 

1. Open Microsoft Project 2016. Click OK on the 

login dialog. 

2. When the application has opened, press the 

Esc key on your keyboard. 

3. Click on File tab in the upper left corner. 

4. Click Options to open the Project Options 

dialog. 

 

 
 

5. In the General tab uncheck “Show the Start 

screen when this application starts”. 

 

 
 

6. Select the Schedule tab. 

 

 
 

7. Select All New Projects from the Calendar 

options for this project dropdown. 
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8. Set the calendar options for your organization. 

 

 
 

9. Select All New Projects from the Scheduling 

options for this project dropdown. 

 

 
 

10. Select Auto Scheduled from the New tasks 

created dropdown. 

 

 
 

11. Select the Advanced tab. 

 

 
 

12. Select All New Projects from the Display 

options for this project dropdown. 

 

 
 

 

 

 

13. Check the Show project summary task 

option. 

 

 
 

14. Click OK. 

15. Close Microsoft Project. 

Starting Your First Project 

Create a new project 

1. Open Microsoft Project 2016. 

2. Upon opening, Project will automatically set 

you up with a blank project. 

Open a project from an existing file 

1. Open Microsoft Project 2016. 

2. Click on File in the upper left corner. 

3. Click on Open. 

 

 

 

4. Select the appropriate folder and file and click 

Open. 

Open a Project from a template 

1. Open Microsoft Project 2016. 

2. Select the File tab. 

3. Select the New menu item and click on the 

template icon. 
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4. Select and download your template. 

 

 

Adjust the Calendar 

1. The default Microsoft Project calendar is called 

Standard. To view and change this calendar 

with Project, select the Project tab on the 

ribbon under Properties. Click on the Change 

Working Time button. 

 

 

2. Once the Change Working Time dialog box 

opens, you will view the Standard Calendar. 

3. To set a holiday as a non-working day, click on 

the Holiday Date. Click in an Open Exception 

line at the bottom. Enter the holiday name. 

Click Enter. Recurring holidays may be entered 

by clicking Details while selecting the holiday 

entry. 

To change daily working time, click on Work 

Weeks at the bottom. Click on Details. Select 

days of the week to be changed, Click the 

third radio button on the right and change 

the working times. Click Enter. 

4. Click OK to close the box.  

 

Set the Project Start Date and apply the 

Project Calendar 

1. Click the Project tab, then click Project 

Information. 

2. Enter the project Start Date. 

3. Select the project Calendar and click OK. 

 

Create Tasks 

1. Ensure the Gantt Chart view is active by 

selecting the Task tab on the ribbon and 

clicking the Gantt Chart button. 

 

 

2. Click in the Task Name cells of the first empty 

task row and enter the name for the task / 

summary task. 

 

 

3. Press the Tab key to move to the duration 

column, and enter the duration in days. 

 
 

4. Create additional tasks and milestones as 

required for your project. Milestones are 

created by specifying zero days of duration. 

 
 

Tip: Keep your duration in the 

same units (e.g. days) 
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Creating a WBS / Outline Structure 
Make a task (or milestone) a child of the preceding 

task by selecting it and clicking on the Indent Task 

button on the Task ribbon tab. You can select multiple 

tasks if there is more than one subtask. 

 

Create Task Dependency Relationships 

Creating relationships between tasks creates the 

timeline of the project. Select a task; hold the Ctrl key 

and select a second task, then click the Link button on 

the Task ribbon tab. The first task becomes a 

predecessor of, and drives the start date of, the 

second. 

 

Multiple tasks and milestones can be linked by 

selecting multiple rows (hold down the Shift and / or 

Ctrl keys) when selecting task rows.

 

Best Practice Tip: Do not link summary tasks. 

Inserting and Deleting Tasks 

To insert a new task row into the middle of your 

project schedule, select a task and either: 

• Press the Insert key on your keyboard, or; 

• Right click the row and select Insert Task. 

A blank row will be inserted above the selected task. 

To delete a task from your project schedule, right click 

on the task and select Delete Task. 

 

Tip: Pressing the Del key will remove the contents of 

the selected cell; it does not delete the task. 

Working with Resources 

Build a team using enterprise resources 

1. With Microsoft Project open, click on the View 

tab on the ribbon bar and select Resource 

Sheet under Resource Views. 

 

 

2. Click on the Resource tab on the ribbon, 

select Add Resources under Insert, and 

choose Build Team from Enterprise. 
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3. In the Build Team dialog, select one or more 

enterprise resources from the list on the left 

side. Use the Shift and / or Ctrl keys to select 

multiple. 

4. Press the Add button to move the selected 

resources to the right side list. 

 

 

5. Select additional resources if required and 

then click OK. 

 

 

Assign resources to tasks 

 

1. Click the Gantt Chart button on the Task 

ribbon to return to the Gantt Chart view. 

 

 

2. Click in the Resource Names cell of a task you 

wish to assign and click the dropdown arrow. 

Select the resource / resources you wish to 

assign to the task. 

 

Alternatively, you can type resource names 

directly into the Resource Names cell. If you 

need to enter more than one, separate the 

resources with commas. 

 

 

View all Task and Resource assignments for a 

Project 

1. To view resource assignments for tasks, click 

the Task Usage button on the View ribbon. 

 

2. To view task assignments for resources, click 

the Resource Usage button on the View 

ribbon. 
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Tip: Add Key Milestones to the Timeline View 

The default view in Project 2016 is a combination of the Gantt 

Chart view with the Timeline view layered above it. In the Gantt 

Chart click the task or milestone you want to add to the 

Timeline view. Right-click the milestone and click Add to 

Timeline. 

Assign a Calendar to a Task 

Note: When a task needs to be performed outside of 

the normal working hours of the Project Calendar, a 

Task Calendar may be assigned to alter the timeframe 

for an individual task. 

1. To assign a Task Calendar, with Microsoft 

Project open, select the Gantt Chart view. 

2. Select the Task you wish to assign to the 

calendar. 

3. Double-click the task or click the Information 

button on the Task ribbon tab. 

 

4. Select the Advanced tab and change the 

Calendar in the Calendar dropdown menu. 

 

 

 

5. Click OK. 

Working with Views 

Select a View 

1. With Microsoft Project open, select the View 

ribbon. 

2. Under the Task View and Resource View 

sections, select the view you wish to use. 

 

 

 

Change the Way the Data is Viewed 

1. You can apply predefined filters and grouping 

to the view by using the Filter and Group By 

dropdowns in the Data section. 

 

 
 

2. You can also filter a view using the quick filter 

for one or more columns. Click the down 

arrow in the column header to show filter 

options. 

 

 
 

3. To sort a view, select a sort order from the 

Sort dropdown on the View ribbon tab. 
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4. Alternatively, sort using the column dropdown 

menu. 

 

 

Create a New View 

1. With Microsoft Project open, click on the View 

tab. 

2. To create a new task view, click on the More 

Views option in the Other Views dropdown in 

the Task Views section. To create a new 

resource view, click on the More Views option 

in the Other Views dropdown in the Resource 

Views section. 

     

3. When the dialog box opens, click on the New 

button. 

 

 

4. Select Single View and click on OK.  

 

 

 

 

5. When the view definition dialog box opens, name 

your new view, select the Screen (type of view) you 

want displayed, and (when appropriate) the table 

to be displayed, then click OK. 

 

 

 

 

 

 

Add a Timeline 

1. To view the timeline, check the Timeline 

option on the ribbon’s View tab. 

 
 

2. The timeline will then appear under the ribbon. 

 
 

3. To add a task or milestone to the timeline, 

right click it (in the Gantt Chart view) and 

select Add to Timeline. 

 

 

 

Tip: The best view to see slippage between baseline 

and actual work is the Detail Gantt view 

www.mpug.com/articles/ask-the-experts-15-

microsoft-project-tips-for-new-users/ 
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Tip: Check out the MPUG article on the new multiple 

timeline feature at 

www.mpug.com/articles/microsoft-project-2016-

preview-multiple-timelines/ 

    

 

 

4. By default a timeline view has only one 

timeline. You can add additional timelines by 

clicking the Timeline Bar button on the 

Format ribbon tab. Note the Format ribbon is 

context-sensitive, so ensure the Timeline view 

has the focus by clicking in it. 

 

 

 

5. If you have multiple timelines, ensure you 

check the appropriate one before adding a 

task or milestone. Tasks and milestones can be 

moved between timelines simply by dragging 

and dropping. 

 

 

Managing a Project 

Set a Baseline 

1. With Microsoft Project open, select the Project 

tab. 

 

 

2. Under the Schedule section, click on Set Baseline. 

 

3. The Set Baseline dialog box will open. Select the 

Baseline you wish to set. 

4. Select whether the Baseline will be for the Entire 

Project or just for Selected Tasks. Click OK.  

 

 

 

Enter Progress Using Percent Complete 

1. With Microsoft Project open and in the 

Tracking Gantt chart view, select the Task 

Name column. 

2. Click on a task you wish to update. 

3. On the Task tab, click the appropriate update 

percentage for the task in the Schedule 

section.  

 

 

4. Note the update values to the right of the 

Gantt bars in the Tracking Gantt chart view.

 

Tip: % Complete represents the percentage of task 

duration that's complete. % Work Complete is the 

percentage of task work hours that are complete. And 

you probably know that time can pass without a 

Tip: There are 11 sets of baseline fields in the system, 

Baseline and Baselines 1-10. The Baseline fields are 

the default used when you first set a baseline. When a 

baseline is updated, you may optionally select one of 

the other 10 sets of Baseline fields or update the 

current Baseline fields. 

http://www.mpug.com/articles/Ask-the-Experts-

Updating-the-Baseline.aspx 
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corresponding amount of work getting done. When 

the percent duration is updated, the percentage of 

work completed is updated also. 

See: www.mpug.com/articles/Certification-Insider-

Tracking-Project-Progress/ 

Reporting 

Create a Project Report 

With Microsoft Project open, select the Report tab. 

1. Under the View Reports section, select one 

of the canned reports from Dashboards, 

Resources, Costs or In Progress. 

 

2. To create a new report, select the report 

style from the New Report dropdown. 

 

 

 

 

 

 

 

 

Create a Visual Report 

1. Click on Visual Reports, under the Project tab. 

 

 

2. When the Create Report Dialog opens, select 

the desired report from the tabs and Click 

View. 

 

3. Your report will open in either Microsoft Excel 

or Microsoft Visio depending on which report 

you select.
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Microsoft Project Keyboard Shortcuts 

 

Action Shortcut 

Show field settings dialog box Alt + F3 

Close Project help window Alt + F4 

Move to end of project Alt + End 

Create new project Ctrl + N 

Open project Ctrl + O 

Save project Ctrl + S 

Insert new task Insert 

Assign resources box Alt + F10 

Close an active project window Ctrl + W 

Switch to next project window Ctrl + F6 

Maximize project window Ctrl + F10 

Remove all tasks filters F3 

Calculate project F9 

Move to beginning of project Alt + Home 

Copy picture of selected window to Clipboard Alt + Print Screen 

Hide subtasks Alt + Shift + - 

Show all tasks Alt + Shift + * 

Show subtasks Alt + Shift + = 

Outdent task Alt + Shift + Left Arrow 

Indent task Alt + Shift + Right Arrow 

Switch to previous window Alt + Shift + Tab 

Activate control menu 
Alt + Spacebar | Alt + 

Hyphen 

Next window Alt + Tab 

Move between tasks Arrow Keys 

Move to end of text box Ctrl + End 

Link selected tasks Ctrl + F2 

Restore size of active window after maximizing it Ctrl + F5 | Ctrl + F10  
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Switch to next window in multiple open windows Ctrl + F6 

Turn auto calculate on or off Ctrl + F9 

Fill down Ctrl + D 

Open “Find” dialog box Ctrl + F 

Open “Go To” dialog box Ctrl + G 

Insert hyperlink Ctrl + K 

Paste Ctrl + V 

Cut Ctrl + X 

Undo Ctrl + Z 

Add object to multi-section Ctrl + Click 

Move to beginning of text box Ctrl + Home 

Move one word to right Ctrl + Right Arrow 

Move one word to left Ctrl + Left Arrow 

Change task to "Auto Schedule" Ctrl + Shift + A 

Unlink selected tasks Ctrl + Shift + F2 

Switch to previous window Ctrl + Shift + F6 

Change task to "Manually Schedule" Ctrl + Shift + M 

Select current column Ctrl + Spacebar 

Jump to first row / last row Ctrl + Up/Down Arrow 

Close active project window Ctrl + W or Ctrl + F4 

Open project help window F1 

Edit task F2 

Remove column filters (when active) F3 

Spellcheck F7 

Extend selection mode F8 

Save as F12 

Jump to first / last cell in row Home / End 

Insert new task Insert 

Open task information dialog box Shift + F2 

Activate split bar Shift + F6 

Shortcut menu Shift + F10 
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NEW MPUG Learning Paths! 
MPUG has created three new learning paths for project managers, developed with YOU in mind, 

addressing your specific training needs! 

See more at mpug.com/mpug-learning-paths-for-project-managers/ 
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